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1 Welcome

1 Welcome
Congratulations on your purchase! NexGen movement monitors are the most advanced in the world, and

provide a complete feature set in a small, attractive, and unobtrusive package.

TK Motion Manager provides an easy to use software interface to our movement monitors and supporting

hardware, and will enable you to:

• Configure your monitor’s settings and features

• Use your hardware for synchronized, wireless streaming of data (SXTs only)

• Use your hardware for synchronized logging of data (SXTs and WXTs only)

• Use your hardware for long duration, non-synchronized logging of data (SXTs, WXTs, and DWTs)

• Recalibrate you monitors

• Organize and view your recorded data

• Keep your hardware up-to-date with firmware updates
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2 Quick Start

2 Quick Start
The following steps are required to get up and running:

1. Turn on your computer and wait for it to boot up.

2. Download TK Motion Manager or use installation media that came with your system. See the Down-

loading TK Motion Manager section of this document for details.

3. Install TK Motion Manager. See the Installing TK Motion Manager section of this document for details.

4. Plug the access point(s) into your computer.

5. If multiple docking stations are chained together, you must plug the external power adapter into the

docking station. You should see the the lights on each docking station turn yellow when power is

applied.

6. Grab a USB cable with a micro (small, flat) connector and plug it into your docking station. If you are

using a USB hub, make sure that it is a USB 2.0 High Speed hub and that it has external power. The

LEDs on the docking station(s) should turn to solid green when they are recognized by the computer.

See special notes in Installing TK Motion Manager if running Windows XP.
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2 Quick Start

7. Dock the movement monitors into their docking stations. You should see the light on the monitors turn

dark blue.

8. Open TK Motion Manager, and click on the “Configure” button. Choose your desired recording mode,

and click “Finish”.

9. Undock the monitors.

10. Wireless streaming mode

a) After about 5-15 seconds, you’ll notice that the LED’s on the monitors will blink green in unison,

and that the access point will have a blinking green LED, indicating that it is receiving data from

the monitors.

b) Press the “Stream” button in the toolbar. You can view live data streaming in the real-time chart.

c) Press the “Record” button to start recording data.

11. Logging modes

a) Undock the monitors from their docking stations. They will start recording within several seconds.

If using the synchronized logging mode, the LEDs on the monitors will blink in unison.

b) When you are done recording, dock the monitors, and press the “Import Data” button in the toolbar

to retrieve the data from the monitors. See “Import Manager” section of this document for details.

9



3 System Overview

3 System Overview
The NexGen movement monitoring system allows the user to record data from multiple monitors; each

integrating a suite of sensors. The system can be configured in 3 recording modes allowing for a wide

rage of applications. Some movement monitors are limited to a subset of these modes allowing for a lower

cost solution. The modes of operation are robust synchronized streaming, rapid synchronized streaming,

synchronized logging, and low power logging. Regardless of the mode the movement monitor always will

record data to its local memory card which can be imported from the monitor for offline analysis.

3.1 Movement Monitors

Movement monitors are the key element of the system and combine a complement of sensors within a single

package. Sensors include a 3 axis accelerometer, a 3 axis gyro, a 3 axis magnetometer, and a temperature

sensor. The accelerometers can be configured in a high 6G mode, or a low 2G mode depending on the

target application. There are a number of options for securing the monitors on subjects using a selection of

straps.

3.1.1 The SXT

The SXT is NexGen’s full featured movement monitor allowing for use of all 4 recording modes.
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3 System Overview

The SXT movement monitor

3.1.2 The WXT

The WXT is an option that supports the synchronized and low power logging modes, but does not support

the streaming modes. These monitors are optimized for long duration recordings or recordings where it is

not desirable to have a computer at hand to collect streaming data.

3.1.3 The DWT

The DWT only supports the low power logging mode. This version of the movement monitor has no wireless

capabilities and may be the optimal choice for RF sensitive environments or where a single movement monitor

is needed without synchronization.

The docking station, for charging, configuring, and downloading data from your movement monitors
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3.2 Docking Station

The docking station is used to configure, charge, and download data from the movement monitors.

3.3 Access Point

The wireless access control point (access point for short) allows for wireless communication between the

host computer and SXT movement monitors, as well as synchronization with external 3rd party hardware. A

single access point can support up to 6 SXTs. If you wish to stream from more than 6 synchronized SXTs

at the same time, you will have to use more than 1 access point and connect them with an RCA (standard

stereo) cable.

The access point, for communicating wirelessly with your movement monitors

3.4 Recording Modes

To suit a range of different recording requirements, a number of different recording modes are possible.

Some monitor types do not support all recording modes.
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3.4.1 Robust Synchronized Streaming

In the robust synchronized streaming mode, you can stream data from multiple, synchronized monitors di-

rectly to your computer. Data is buffered on the monitors, so no data is lost even if there are interruptions in

the wireless signal. Only the SXTs can be used in this mode.

3.4.2 Rapid Synchronized Streaming

The rapid synchronized streaming mode is similar to the robust synchronized streaming mode, except data

is not buffered on the monitors in order to minimize the latency of the streaming data. Latency on Linux and

Mac OS is typically in the range of 8ms to 25ms, while latency on Windows is typically in the range of 10ms

to 75ms. This recording mode is appropriate for biofeedback applications. In the event of interruptions in the

wireless signal, data will be dropped from the steram. Only the SXTs can be used in this mode.

3.4.3 Synchronized Logging

In the synchronized logging mode, monitors log recorded data to their on-board flash memory. The monitors

are synchronized wirelessly with each other while recording, so the individual logs can easily be synchronized

with each other after the data has been imported from your monitor(s). In this mode, up to 24 monitors can

be synchronized within a single “mesh”. Only WXTs and SXTs are able to use this mode.

3.4.4 Low Power Logging

All movement monitor products (SXTs, WXTs, and DWTs) are able to operate in the low power logging

mode. In this mode, the monitors’ wireless radios are disabled, decreasing the power required for operation

and enabling the monitors to run for longer periods of time. Since the mode does not use any wireless

synchronization, each movement monitor will collect data independently and potentially at slightly different

rates due to clock drift.

3.5 TK Motion Manager

TK Motion Manager is the default software suite bundled with the I2M movement monitor system. It provides

an easy way to get up and running collecting data with your movement monitors.
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3.6 NexGen Software Development Kit

The NexGen Software Development Kit (SDK) provides programming tools for software developers. These

tools enable developers to write their own software capable of configuring and streaming data from the

movement monitors. In addition, it also provides functions for converting the raw data files found on the

monitor’s memory card into either a HDF5 (recommended) format or CSV. The SDK provides the same low

level interface to the hardware that TK Motion Manager is built upon.
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4 Downloading TK Motion Manager
TK Motion Manager is supported on the following platforms:

• Apple Macintosh OSX 64-bit

• Apple Macintosh OSX 32-bit

• Windows 32-bit (XP, Vista, Windows 7)

• Windows 64-bit (Vista, Windows 7, Windows 8)

• Linux 32-bit

• Linux 64-bit

To download the latest version of TK Motion Manager, visit:

http://www.humancad.com/downloads/I2M/

and select the version that matches your operating system.

The download includes everything you need to get started, including:

• Drivers

• Firmware

• The TK Motion Manager desktop application

Note (Windows Only): To simplify the Java configuration on the Windows platform, the 32- and 64- bit versions

of TK Motion Manager come pre-bundled with the appropriate Java Runtime Environment (JRE). This adds

about 70 Mb to the download size, but removes a major variable in the installation process.

Note (MacOSX and Linux): TK Motion Manager requires Java 1.6 to run. Make sure your Java installation

is up to date before attempting to launch the application. In order to use the 64-bit version of TK Motion

Manager, you also need to have the 64-bit Java JRE installed.
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5 Installing TK Motion Manager

5.1 Macintosh OSX (x32/x64)

• Unzip the contents of the downloaded zip file into the directory of your choice. Typically, it will go into

your Applications directory. No further steps are required.

5.2 Windows

• Double click on the downloaded Mobility Lab setup file. This will guide you through the installation

process.

Note: In Windows 8, when you launch the installer you will see a dialog indicating “Windows protected your

PC” along with a “More info” link and an “OK” button at the below. This behavior is expected. Click on the

“More info” link and select “Run anyway”.

Note: If you see a Windows User Account Control dialog asking “Do you want to allow the following program

from an unknown publisher to make changes to this computer”, select “Yes”.

5.2.1 USB 3.0 XHCI

NEC/Renesas: NEC/Renesas USB 3.0 controllers must upgrade to the latest driver and firmware versions,

available at http://www.station-drivers.com/index.php/downloads/Drivers/Renesas-Nec/USB-3.0/ . Make sure

to match the chipset number you have to the firmware/driver version you are downloading. You can check

this using device manager, under the ”Universal Serial Bus Controllers” section. You will see an ”Renesas

Electronics USB 3.0 Host Controller” or a ”Renesas Electronics USB 3.0 Root Hub”.

Via Labs: The Via Labs VL800 USB 3.0 XHCI Host Controller requires the latest drivers, downloadable from

via at http://via-labs.com/en/support/downloads.jsp#hostdriver . Older versions of this driver are known to

have problems.

Texas Instruments: May 2014: Texas Instruments 7330 and 7340 XHCI USB 3.0 chipsets are not yet sup-

ported. There are various issues with the TI driver and libusbx that do not allow it to work consistently. TI and

the libusbx development teams are currently working on this and we expect driver fixes and new libraries to

be available sometime in the future, at which point the APDM hardware should work properly when connected

to TI USB 3.0 XHCI host controllers.
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5.2.2 Windows XP

Windows XP will prompt you with the “Found New Hardware” wizard every time you plug an access point

or docking station into a USB port for the first time. This happens even if you have already installed it on a

different port, and may even happen if you have already installed it on the same port. This is a “feature” of

Windows XP and not an issue in Vista or Windows 7/8. If you have a chain of multiple docking stations, you

will be prompted for each one.

When you are prompted with the “Found New Hardware” wizard:

• Select the “No, not this time” option and click “Next”

• Select the “Install the software automatically” option and click “Next”.

5.3 Linux (x32/x64)

• Unzip the contents of the downloaded zip file into the directory of your choice.

The appropriate permissions have to be set to interface with the hardware devices. This can be configured

via the udev system. The user will need access to devices with the following vendor ID (VID) and product ID

(PID):

Access Point: VID: 0x224F PID: 0x0001

Docking Station: VID: 0x224F PID: 0x0002

Different distributions use different methods of setting up UDEV rules. Details for some of the distributions

can be found at the following URLs:

• Ubuntu: http://manpages.ubuntu.com/manpages/karmic/man7/udev.7.html

• Debian: http://wiki.debian.org/udev

• Redhat: http://www.redhat.com/magazine/002dec04/features/udev/

An example set of udev rules for the access point and docking station are as follows:

ACTION=="add", ATTRS{idVendor}=="224f", ATTRS{idProduct}=="0001", MODE:="0666"

ACTION=="add", ATTRS{idVendor}=="224f", ATTRS{idProduct}=="0002", MODE:="0666"

For example, under Debian, you would run the following command:

%> sudo pico /etc/udev/rules.d/86-apdm.rules
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5 Installing TK Motion Manager

then copy and paste the above udev rule block in, save the file, and restart udev with

%> sudo /etc/init.d/udev restart

Note: The “keucr” driver has been known to cause problems with mounting SD cards from the docking

stations. If you experience SD card mounting issues, check to see if the “keucr” driver is loaded and unload

it using the appropiate methods for your Linux distribution.
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6 TK Motion Manager
TK Motion Manager is the default software suite bundled with the I2M movement monitor system. It provides

an easy way to get up and running collecting data with your movement monitors. It also provides advanced

configuration, recording, calibration, and data management features that enable you to take full advantage

of the I2M movement monitor system.

The TK Motion Manager workspace
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7 Configuration
NexGen movement monitors can be configured in a number of ways to match your recording needs. The

Configuration Status Tool that is found in the toolbar provides immediate information about your current

recording mode and status. The Configuration Dialog, on the other hand, allows you to change your con-

figuration settings including your configuration mode, which sensors are enabled, external synchronization

options, and more.

7.1 The Configuration Status Tool

The Configuration Status tool in the toolbar

The Configuration Status Tool provides immediate information about your current recording mode and status,

in addition to troubleshooting help and quick links to re-apply or change your current configuration.

• Recording Mode. This field displays which recording mode you are currently configured for. These

options include:

– Robust Synchronized Streaming (SXTs only)

– Rapid Synchronized Streaming (SXTs only)

– Synchronized Logging (SXTs and WXTs only)

– Low Power Logging (SXTs, WXTs, and DWTs)

• Current Status. This field indicates whether your current recording mode is “Configured” or “Unconfig-

ured”. Assuming all of your monitors are powered on, an “Configured” status indicates that your system

is ready to record. Streaming modes become “Unconfigured” when the access point, which stores the

streaming configuration, is power cycled (e.g., by unplugging the USB cable or by putting your laptop to

sleep). Logging modes remain “Configured”, although you may need to power your monitors back on

by re-applying the configuration to enable recording if they were powered down for storage.

• Re-apply. This button will re-apply your current configuration. For most use cases, this makes it

unnecessary to re-configure your system at startup through the Configuration Dialog – as long as your

configuration options do not change. By default, your saved configuration is re-applied at TK Motion

Manager startup time. It is recommended that you have all configured monitors docked at startup to

ensure that they are powered on and that their clocks are reset.

• New. This button will open the Configuration Dialog, enabling you to create and apply a new system

configuration. The configuration will be saved so that it can be re-applies later on.

• Configuration Help. This button will open up a dialog with an overview of your current configuration

and tips to help ensure successful recording.
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7.2 The Configuration Dialog

7.2.1 System Configuration

The system configuration options of the configuration dialog

Attached Hardware: This window displays the NexGen hardware that is detected on your computer. If this list

does not accurately specify the hardware that you have attached, you should press the “Rescan Hardware”

button (see the next topic) to initiate the scan again.

Rescan Hardware: This option will search for NexGen hardware attached to your computer and refresh the

configuration dialog.

Record Mode: Use this option to specify how you wish to record data from your monitors.
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Wireless Channel: Monitors configured for wireless streaming or synchronized logging transmit data in the

2.4 ghz wireless spectrum range. Channel zero corresponds to roughly 2.40 ghz, and channel 90 corre-

sponds to roughly 2.49 ghz. Many other consumer electronic devices make use of radio frequencies in the

2.4 ghz spectrum, such as WiFi routers, cordless phones, and blue-tooth devices. Because of this, it’s impor-

tant to choose a channel that is not heavily in use by another device or you may experience wireless issues.

If you experience wireless issues, the most common source of interference is from WiFi routers. You can

determine the channel that your WiFi router is running on and determine its corresponding frequency from

the following URL: http://en.wikipedia.org/wiki/IEEE_802.11.

7.2.2 Monitor Configuration

Use the “Select Monitor” combo box to specify the monitor you wish to individually configure.

The monitor configuration options of the configuration dialog

Copy Configuration to All Monitors: When this button is pushed, the configuration for the currently selected

monitor will be copied to all currently docked monitors, with the exception of the “Monitor Label” configuration
22
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option.

Sensors: Enable or disable on-board sensors. If your application does not require data from a particular

sensor type, turning them off can reduce file sizes and improve battery life. The gyroscopes in particular use

a significant amount of battery power.

Accelerometer Range: Specifies whether the range of the accelerometer is ±2 g or ±6 g. This is approxi-

mately equal to ±20 or ±60 m/ s2, although some sensors may have a slightly larger range before saturating.

If your application does not need the full ±6 g range, using the ±2 g range will slightly improve the signal to

noise ratio (SNR) of your accelerometer readings.

Spin mode: You can optionally assign an action to occur when the monitor is spun clockwise or counter-

clockwise about it’s z-axis. For example, spinning the monitor when it is lying flat on a table. Gyroscopes need

to be enabled on the monitor in order to make use of this feature. The following spin modes are available:

• Do Nothing.

• Power Down. When this setting is used, the monitor will power down completely when spun rapidly.

The monitor will need to be reconfigured before the next use in order to reset the clock. This mode is

appropriate for short to long term storage.

• Standby. When this setting is used, all components except the clock are powered down. This mode

is appropriate for short term storage (a few days). The monitor will start recording again the next time

it is docked and undocked. If it has been stored long enough for the battery to completely run out,

reconfiguring or pressing the “Power On” button while it is docked will reset the clock.

Battery Indicator Interval: Specifies how often the LED sequence indicating the current battery level is dis-

played. This can be set from a value of 3 s to 768 s. The battery level is indicated by the number of blinks,

ranging from 1 blink (low battery) to 4 blinks (full battery). The battery indicators on synchronized monitors

will also be synchronized.

Battery Charge Cutoff: Specifies the charge level at which the monitor goes into standby mode. This is

particularly useful for application where the monitors will not be re-configured between uses and it is desired

to keep the clocks running. For example, daily monitoring of a subject that is planning on charging overnight

via a charging cable, but not planning on reconfiguring in the morning. If the cutoff level is set to 0%, the

battery will completely drain before powering down. If the cutoff level is set to 50%, the monitor will enter

standby mode when 50% of the charge is left. This extreme provides for two or more days of operation in

standby mode before the battery is dead and the clock is reset. It will also, however, impact the running time

of the monitor.
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Monitor Label: By specifying a label for a monitor, this label will be persisted along with the data in both

the CSV and HDF file types. Example labels are “Right Arm” and “Jane Doe”. This is often easier than

associating data with a monitor ID (e.g., “56”). There is a 15 character limit for the label.

Enable Button: If selected, the monitor will process events triggered by an external button. See Section 11

for details. If unselected, button events will not be processed, even in the presence of an external button.

Erase Saved Data: Pressing this button will delete all of the recorded data on the specified monitor. This

does not include configuration data. The data is deleted the next time the monitor is undocked.

Update Calibration Data: Use this option in the event that your monitor needs to have its calibration data

updated. You will have to specify the calibration file to use.

View Debug Info: This option allows you to print out detailed information about the monitor configuration

and a log of any errors that have been encountered during its operation. The output is placed into a special

page in the console view of the main application. Use the “Display Selected Console” button to select the

appropriate console view.

Clear Error Log: Use this option to clear the error log on the monitor. This is useful when debugging to

ensure that error log entries are not historical.

LED Debug Mode: When this option is selected, the monitor’s LED will display debug information while

recording, instead of blinking in unison with the rest of the monitors. See Monitor Reference for details on

the LED modes.

7.2.3 When you are done configuring your system

Press the “Configure” button to complete the configuration. When the configuration progress dialog com-

pletes, unplug your monitors from their docking stations.

7.3 Automatic Firmware Updates

Whenever you open the Configuration Dialog, your hardware is first checked to ensure that the latest firmware

is installed. If not, you will be prompted to automatically update your hardware to the latest versions of the

firmware bundled with TK Motion Manager.
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8 Synchronized Streaming Modes
If one of the synchronized streaming modes (robust or rapid) is selected in the configuration dialog (SXTs

only), you can stream data from multiple, synchronized monitors directly to your computer.

The synchronized streaming dialog

8.1 Starting a Streaming Session

To start a streaming session, press the “Stream” button in the application tool bar to bring up the recording

dialog.

The “Stream” button in the toolbar

The stream dialog will enable you to configure how you view and record streaming data from your SXTs.

Note: If you notice excessive latency or a very slow frame rate, consider unchecking the “Enable” checkbox,
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which will stop the real time plotting of data and free up more processing power on your computer.

8.2 Record Duration

You can select between fixed and indeterminate recording durations:

Fixed duration. You can specify the number of hours, minutes, and seconds for each recording. You can

press the “Stop” button to stop your recording before the specified duration has lapsed.

Indeterminate duration. Your recording will continue until you press the “Stop” button.

External Sync. When this option is selected, the “Record” button will be disabled and the system will wait

for external synchronization events to start and stop recording. See section 20 for more details.

8.3 Save Options

8.3.1 File Format

You can record to either the HDF5 (http://www.hdfgroup.org/) or the CSV file format.

HDF5 is an open format for storing structured, binary data. Files are more compact than their CSV coun-

terparts and can be opened directly in a number of analysis software packages, including Matlab. See the

chapter on “Working with HDF5 Files” in this document for more information.

CSV is a plain-text format that can be opened in spreadsheet software applications, such as Excel or OpenOf-

fice, in addition to most analysis software.

8.3.2 File Name

Specify the name of the data file recorded to disk.

8.3.3 Prepend Date

If checked, the date and time of the start of the recording are added to the beginning of the file name.
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8.4 Statistics

8.4.1 Latency

Displays the current latency between the time data is recorded to the time it is received by the computer.

Latency may be increased by poor wireless reception or monitors that are occluded from the access point

(e.g., against a metal chair back, around a corner, etc.). Additional latency will be incurred by the plotting of

the data to the screen.

8.4.2 Dropped Samples

Displays the number of samples dropped since the current streaming session was started. There are only

a few extreme cases where samples will be dropped when using the robust streaming mode. In the event

that data is dropped, all of the recorded data will be present on the monitor’s on-board memory and can be

recovered manually using the Import Manager after the monitor is docked.

8.5 Annotations

You can use the annotation buttons to add annotations to an ongoing recording. When the button is clicked,

a timestamped marker will be added to the recorded file (HDF only). If you add text to the text box on the

right side of either button, the text will be added to the annotation. See Section 7 for details about the HDF

format and the location of the annotations. You can also use a remote to annotate your data from a distance

(see Section 8.8 for details).

The annotations panel in the stream dialog

8.6 Real Time Chart

Use the “Select Monitor” combo box to view the real-time data from different monitors (subject to wireless

and plotting latency). You can view the state of the external button (if enabled and attached) in the “Button

State” field. A value of ‘1’ indicates the button is pressed, while a value of ‘0’ indicates that it is not.

The real time chart allows you to view the data streaming from your monitors. There are a number of

visualizations currently implemented:
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• Strip Chart. This shows the calibrated data from all activated sensors for the selected monitor with

the most recent streamed data appearing on the right of the chart and moving to the left. There is a 2

second window.

• Orientation. This shows the estimated orientation of the monitor as a rendered 3D model. To initialize

the visualization, hold your monitor such that the port is facing you and press on the “Center” button.

Note: the orientation calculations are dependent, in part, on measurements from the magnetometers.

If you are in a location with non-uniform magnetic fields (as is common around metal objects or other

ferrous material), the orientation estimates may be compromised.

• 2-D. This shows one of the axes of an individual accelerometer or gyroscope versus one of the other

axes. For example, “Y vs. Z Accelerometer” or “X vs. Y Gyroscope”.

The Orientation Visualization

8.7 Starting and stopping

When you are ready to record press the “Record” button in the stream dialog.

To stop your recording press the “Stop Button”. Your data will be saved to your current working directory

and the recording will be plotted on the screen.

The record dialog will then prepare for additional recordings.

8.8 Remote Control

TK Motion Manager supports the use of a remote control to aid while recording in the Synchronized Stream-

ing mode. This functionality makes it possible to start and stop recording at a distance from your computer.
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8.8.1 Supported Remotes

TK Motion Manager has been designed to use a standard presentation remote intended for navigating a

slide presentation in Power Point or similar software. Our preferred remote is the Logitech R400, but other

presentation remotes will most likely work out of the box because the buttons are often standardized.

8.8.2 Enabling the Remote

Enabling and disabling the remote can be performed in the streaming dialog by clicking on the ”Enable

Remote” checkbox below the Stop and Record buttons. When the remote is enabled, on-screen buttons

that are mapped to remote functionality will have their standard icons either overlayed or replaced by special

remote icons. These icons are modeled after those on the Logitech R400 remote to make the mapping clear.

Currently, the start and stop buttons are mapped to the “Next” and “Previous” slide buttons on the remote.

The annotation buttons are mapped to the “Start” and “Stop” presentation buttons on the remote.

Examples of TK Motion Manager button icons that map to remote control buttons
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9 Synchronized Logging Mode
If the synchronized logging mode is selected in the configuration dialog (SXTs and WXTs only), you can

log data from more than one monitor to their on-board flash memory and the monitors are synchronized

wirelessly with each other.

9.1 To start recording

Disconnect the monitors from their docking stations after configuration. After a few seconds to initialize, they

will start recording to their flash memory. When within wireless contact with one-another, they will synchronize

their clocks. To start an additional recording in a separate file, connect and disconnect the monitors from their

cables or docking stations. No re-configuration is necessary.

9.2 To import recorded data

Plug the monitor into a docking station. Click on the ”Import Data” button in the toolbar. See Section 12 for

information about using the Import Manager.
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10 Low Power Logging Mode
If your monitors are configured for low power logging (SXTs, WXTs, and DWTs), you can log data from one

or more monitors at a time to their on-board flash memory. Wireless radios are turned off to save power.

Multiple monitors will not be synchronized, and some level of clock drift will occur during long recordings.

10.1 To start recording

Disconnect the monitors from their cables or docking stations after configuration. After a few moments to

initialize, they will start recording to their flash memory. When within wireless contact with one-another,

they will synchronize their clocks. The monitors will stop recording once they are docked again. No re-

configuration is necessary.

10.2 To import recorded data

Plug the monitor into a docking station. Click on the ”Import Data” button in the toolbar. See Section 12 for

information about using the Import Manager.
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11 External Button Event Handling
NexGen offers an optional button that fits into the data port of an undocked monitor. This button allows for

additional functionality while recording including:

• Inserting event markers into the data stream

• Stopping and starting recording

11.1 Enabling the button

The button is enabled via the Monitor tab in the configuration dialog box. See Section 7.2.2 for details.

After undocking a monitor with button handling enabled, you must insert the button into the data port on the

monitor. The button must be removed again before the monitor can be docked.

11.2 Event Markers

Often it is desirable to record the time of external events directly into the data stream for offline analysis.

The external button provides a mechanism for doing this. Note: when streaming data, you may find that

annotations provide a nice solution to this problem (HDF file format only). See Section 8.5 for more details

about annotations.

Pressing the button will insert the button state (up/down) into the data stream of the monitor the button is

connected to. A maximum of one button transition (on→off or off→on) can be recorded every 10ms. The

button state is stored on a sample-by-sample basis (much like the sensor data) in the output file. Both

CSV and HDF file formats support the storage of the button state. A value of ‘1’ indicates that the button is

pressed, while a value of ‘0’ indicates that the button is not pressed. If you are using one of the streaming

modes, the current button state is indicated in the “Button State” field in the Stream Dialog (make sure you

have selected the correct monitor in the “Select Monitor” drop-down when viewing the button state). This is

a good way to test that the functionality is working.

11.3 Starting and Stopping Recordings

If the button is held down for at least 3 seconds the monitor will transition into a “hold” mode where recording

is halted. The led will indicate this mode by a slow blue blink pattern. If the button is released and held

for another 3 seconds while halted, the monitor will start running again and a new recording will be started.

Please note the following:

• When you halt a monitor using the external button, any other monitors currently in use will continue to
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record. We plan on improving this functionality in the future so that the button can be configured to halt

all monitors when in the synchronized streaming mode.

• When in the hold state, the sensors remain powered up. Because of this, it is not intended to be used as

a mechanism to significantly improve battery life. Instead, it is intended to be a mechanism to partition

your recordings when using one of the logging modes.

• Because of these current limitations, the button is best used for stopping/starting recordings when using

a single monitor in the low power logging mode.
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12 Import and Conversion Manager
The Import and Conversion Manager enables you to import logged data saved on your monitors and to

convert these data to a format that can be read by a number of software analysis packages. Click on the

“Import” button in the toolbar to open the Import and Conversion Manager.

The Import button in the toolbar

When you open the import manager, the data from all currently docked monitors are moved to an import

directory within the installation folder on your PC. These raw data files are displayed in the table at the top of

the import directory. At the bottom of the dialog is a status indicator to help guide you through the conversion

process.

The Import and Conversion Manager dialog window
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12.0.1 Selecting Data For Import

In the table at the top of the Import and Conversion Manager, you select data for conversion by checking the

checkboxes of the files you wish to convert.

When you select a file in the table by clicking anywhere on the row, any other files that have overlapping

recording times will be highlighted. This functionality aids in finding and merging of data that was recorded

on multiple monitors synchronously.

12.0.2 Conversion Options

File Format. You can record to either the HDF5 (http://www.hdfgroup.org/) or the CSV file format. HDF5

is an open format for storing structured, binary data. Files are more compact than their CSV counterparts

and can be opened directly in a number of analysis software packages, including Matlab. See Section 7 in

this document for more information. CSV is a plain-text format that can be opened in spreadsheet software

applications, such as Excel or OpenOffice, in addition to most analysis software.

Include Raw Data. Select this option if you want to include the raw sensor data in the import file. This is the

raw sensor data, and has not been processed or converted to SI units.

Compress Data. When importing data into an HDF5 file, you can choose the compress the data. The

resulting file will be significantly smaller, but it will take longer to perform the import. Note: Matlab versions

before 2009a cannot read compressed HDF5 data.

Delete Data After Import. When selected, the raw data will be deleted after import.

Include Filtered Data (HDF Only). When selected, dynamic estimates of the gyro bias are removed from

the recordings. These filtered results are stored in a separate group in the HDF file, such that the standard

calibrated output is also present.

12.0.3 File Naming Options

Base File Name. Specify the base name of the data file the data is being imported into.

Include Monitor ID. If selected, the case ID of the monitor being imported from will be embedded in the file

name.

Include Monitor Label. If selected, the label of the monitor being imported from will be embedded in the file

name.

35



12 Import and Conversion Manager

Prepend Date. If checked, the date and time of the start of the recording are added to the beginning of the

file name.

12.0.4 Time Range to Extract

Recordings logged on different monitors will, in general, not perfectly overlap with each other in the time

domain. This is because logging begins as soon as a monitor is undocked and stops as soon as it is docked

again. Unless you undock and dock your monitors at exactly the same time, each monitor will log data from

slightly different time spans. Using the timestamps generated on each monitor, however, it is possible to

extract synchronized data from a group of monitors whose recordings overlap. The Time Range tool will help

you extract synchronized data from your logged recordings:

• When you select a group of overlapping recordings, the Time Range tool will display the earliest and

latest common time within the group. This is the time span for which data is available from all of the

selected devices. By default, this is the data that will be converted.

• If the selected files do not overlap temporally, you will not be able to convert the data.

• If you wish to extract a subset of the overlapping region, you can specify the start and stop times (in

epoch milliseconds) in the “Crop Start Time” and “Crop End Time” text boxes.

• If you wish to extract all of the data from each of your selected monitors, and not just the data from the

time span when all monitors were recording, you can select the “Convert All Data” checkbox.

12.0.5 After Conversion

Converted data will show up in your current working directory. Right click on it and select ”Plot” to plot the

data to the screen.
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13 Managing Your Data

13.1 The Data Explorer

The Data Explorer can be used to help you organize and view your data.

The Data Explorer view

The Data Explorer shows a hierarchical view of your projects and folders. Projects are the top level containers

in the Data Explorer, and can hold any number of folders. Folders hold other folders or data files. The projects

and folders that are visible in the Data Explorer are called your Workspace.

13.1.1 Working Directory

The Working Directory Tool is displayed in the application’s toolbar. You can change your Working Directory

by clicking on the “Change” button and selecting a different project or folder.

The Working Directory Tool in the toolbar

Whenever you record data through the streaming interface or import logged data from your monitor(s), the

data will appear in your current Working Directory.

13.1.2 Creating new projects

1. Right-click in the Data Explorer and select “New→ Project...”

2. Select the “Project” option from the New Project Wizard

3. Specify the project name

4. By default, the project and all contained files will be placed in TK Motion Manager’s workspace directory,

which is indicated in the console when TK Motion Manager is launched. If you wish to specify a different

location on your hard drive to create the project, uncheck the “Use default location” checkbox and

choose the location of the new directory.
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5. Click “Finish”

6. To make this your current working directory, click on the “Change” button in the Working Directory Tool

and choose the new project.

13.1.3 Creating new folders in projects

1. Right-click in the Data Explorer and select “New→ Folder”

2. Select the parent project or folder for the folder you wish to create

3. Specify the folder name

4. By default, the folder will be created in the project’s directory structure on your hard drive. It is possible,

however, to associate the folder with a project but to store the data in a different location. If you wish

to specify a different location on your hard drive to create the folder, click the “Advanced” button, select

the “Link to alternate location(Linked Folder)” option, and specify the folder on your hard drive that you

wish to store this folder’s data in.

5. Click “Finish”

6. To make this your current working directory, click on the “Change” button in the Working Directory Tool

and choose the new folder.
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13.2 Plotting

To plot a recorded file, either double-click on the file in the Data Explorer, or right-click on the file and select

the “Plot” option. The plot dialog enables you to specify the monitor to plot.

The data plot view
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14 Working with HDF5 Files
HDF5 is the preferred format for storing NexGen movement monitor data. It is a standard format for scientific

data that is efficient and widely supported. It uses less space than CSV, is faster to load, and supports more

structured data. This section will cover the organization of the NexGen movement monitor data and the

basics of reading HDF5 files in MATLAB.

14.1 HDFView

A free program called HDFView (http://www.hdfgroup.org/hdf-java-html/hdfview/) can be used to

explore, plot, and export this data into other formats. A variety of free open source tools for working with HDF

files are also available at http://www.hdfgroup.org/HDF5/release/obtain5.html.

14.2 Data Organization

HDF5 files are organized like a file structure. The root of the file contains two attributes. One is a list of

monitor IDs that have data stored in this file. The other is a version number for the organization of the HDF

5 file.

14.3 File Structure

14.3.1 Versions 3 and 4

• MonitorLabelList Attribute containing an array of monitor labels in the same order as the CaseIdList

• CaseIdList Attribute containing an array of monitor case IDs in the same order as the MonitorLabelList

• FileFormatVersion Attribute containing the file format version (3)

• Annotations Table containing annotations

– Time Annotation time in epoch microseconds

– Case ID A movement monitor case ID associated with the annotation

– Annotation The annotation string

• AA-XXXXXX A group is included in the file for each monitor in the CaseIdList, with the name equal to the case ID

– FilteredDataPopulated (version 4) Attribute indicating the present of the filtered data group

– SampleRate Attribute containing the output data rate for the monitor

– DecimationFactor Decimation factor for the monitor’s internal processing

– ModuleID The module ID for the monitor

– TimeGood Flag indicating whether the time has been set on the monitor since it powered on

– RecordingMode One of: ”Wireless streaming”, ”Synchronized logging”, or ”Unsynchronized logging”

– DataMode Indicates whether the data was retrieved wirelessly or copied from the monitor’s internal storage while

docked. One of: ”Streamed wirelessly” or ”Logged to monitor”
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– AccelerometersEnabled 1 for enabled, 0 for disabled

– GyroscopesEnabled 1 for enabled, 0 for disabled

– MagnetometersEnabled 1 for enabled, 0 for disabled

– DecimationBypass Internal use, deprecated

– CalibrationVersion Version of the calibration data used to convert from raw samples to calibrated SI units

– VersionString1 Firmware version string 1

– VersionString2 Firmware version string 2

– VersionString3 Firmware version string 3

– CalibratedDataPopulated (version 3) 1 for populated, 0 for unpopulated

– CalibratedData (version 4) Calibration data for the monitor

– LocalTimeOffset Time in microseconds to add to UTC to convert to local time

– SyncValue Dataset containing the internal sync value for each sample

* Units Attribute string containing the timestamp units (1/2560th of a second since 0:00 Jan 1, 1970 UTC)

– Time Dataset containing a timestamp for each sample

* Units Attribute string containing the units (microseconds since 0:00 Jan 1, 1970 UTC)

– ButtonStatus Dataset containing the button status for each sample (1==pressed, 0==unpressed)

– Calibrated Group containing calibrated data

* Accelerometers Dataset containing accelerometer data (Nx3)

· Units Attribute string containing the accelerometer units (m/s2)

· Range Attribute containing the range setting for the accelerometer (2g or 6g)

· Gravity (version 4) Attribute indicating the gravity constant used in orientation estimation

* Gyroscopes Dataset containing gyroscope data (Nx3)

· Units Attribute string containing the gyroscope units (rad/s)

* Magnetometers Dataset containing magnetometer data (Nx3)

· Units Attribute string containing the magnetometer units (µT)

* Temperature Dataset containing the temperature (Nx1)

· Units Attribute string containing the temperature units (◦C)

· EarthFieldMagnitude (version 4) The field constant used in orientation estimation

* TemperatureDerivative Dataset containing the temperature derivative (Nx1)

· Units Attribute string containing the temperature derivative units (◦C/s)

* Orientation Dataset containing the orientation quaternion (Nx4). The orientation is relative to a (magnetic) north,

west, up reference frame. The scalar component of the quaternion is the first element.

– Raw Group containing raw data if selected during import

* Accelerometers

* Gyroscopes

* Magnetometers

* DataFlags

* OptData

* Temperature

* TemperatureDerivative

– Filtered (version 4) Filtered data set. This set is intended for post-processed data. Currently the gyro biases are

removed from the gyroscope signals. In the future, additional filtering may be implemented.

* Accelerometers

* Gyroscopes
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* Magnetometers

14.3.2 Version 3

• MonitorLabelList Attribute containing an array of monitor labels in the same order as the CaseIdList

• CaseIdList Attribute containing an array of monitor case IDs in the same order as the MonitorLabelList

• FileFormatVersion Attribute containing the file format version (3)

• Annotations Table containing annotations

– Time Annotation time in epoch microseconds

– Case ID A movement monitor case ID associated with the annotation

– Annotation The annotation string

• AA-XXXXXX A group is included in the file for each monitor in the CaseIdList, with the name equal to the case ID

– SampleRate Attribute containing the output data rate for the monitor

– DecimationFactor Decimation factor for the monitor’s internal processing

– ModuleID The module ID for the monitor

– TimeGood Flag indicating whether the time has been set on the monitor since it powered on

– RecordingMode One of: ”Wireless streaming”, ”Synchronized logging”, or ”Unsynchronized logging”

– DataMode Indicates whether the data was retrieved wirelessly or copied from the monitor’s internal storage while

docked. One of: ”Streamed wirelessly” or ”Logged to monitor”

– AccelerometersEnabled 1 for enabled, 0 for disabled

– GyroscopesEnabled 1 for enabled, 0 for disabled

– MagnetometersEnabled 1 for enabled, 0 for disabled

– DecimationBypass Internal use, deprecated

– CalibrationVersion Version of the calibration data used to convert from raw samples to calibrated SI units

– VersionString1 Firmware version string 1

– VersionString2 Firmware version string 2

– VersionString3 Firmware version string 3

– CalibratedDataPopulated 1 for populated, 0 for unpopulated

– LocalTimeOffset Time in milliseconds to add to UTC to convert to local time

– SyncValue Dataset containing the internal sync value for each sample

* Units Attribute string containing the timestamp units (1/2560th of a second since 0:00 Jan 1, 1970 UTC)

– Time Dataset containing a timestamp for each sample

* Units Attribute string containing the units (microseconds since 0:00 Jan 1, 1970 UTC)

– ButtonStatus Dataset containing the button status for each sample (1==pressed, 0==unpressed)

– Calibrated Group containing calibrated data

* Accelerometers Dataset containing accelerometer data (Nx3)

· Units Attribute string containing the accelerometer units (m/s2)

· Range Attribute containing the range setting for the accelerometer (2g or 6g)

* Gyroscopes Dataset containing gyroscope data (Nx3)

· Units Attribute string containing the gyroscope units (rad/s)

* Magnetometers Dataset containing magnetometer data (Nx3)

· Units Attribute string containing the magnetometer units (µT)

* Temperature Dataset containing the temperature (Nx1)
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· Units Attribute string containing the temperature units (◦C)

* TemperatureDerivative Dataset containing the temperature derivative (Nx1)

· Units Attribute string containing the temperature derivative units (◦C/s)

* Orientation Dataset containing the orientation quaternion (Nx4). The orientation is relative to a (magnetic) north,

west, up reference frame. The scalar component of the quaternion is the first element.

– Raw Group containing raw data if selected during import

* Accelerometers

* Gyroscopes

* Magnetometers

* DataFlags

* OptData

* Temperature

* TemperatureDerivative

14.3.3 Version 2

• MonitorLabelList Attribute containing an array of monitor labels in the same order as the CaseIdList

• CaseIdList Attribute containing an array of monitor case IDs in the same order as the MonitorLabelList

• FileFormatVersion Attribute containing the file format version (2)

• Annotations Table containing annotations

– Time Annotation time in epoch microseconds

– Case ID A movement monitor case ID associated with the annotation

– Annotation The annotation string

• AA-XXXXXX A group is included in the file for each monitor in the CaseIdList, with the name equal to the case ID

– SampleRate Attribute containing the output data rate for the monitor

– DecimationFactor Decimation factor for the monitor’s internal processing

– ModuleID The module ID for the monitor

– TimeGood Flag indicating whether the time has been set on the monitor since it powered on

– RecordingMode One of: ”Wireless streaming”, ”Synchronized logging”, or ”Unsynchronized logging”

– DataMode Indicates whether the data was retrieved wirelessly or copied from the monitor’s internal storage while

docked. One of: ”Streamed wirelessly” or ”Logged to monitor”

– AccelerometersEnabled 1 for enabled, 0 for disabled

– GyroscopesEnabled 1 for enabled, 0 for disabled

– MagnetometersEnabled 1 for enabled, 0 for disabled

– DecimationBypass Internal use, deprecated

– CalibrationVersion Version of the calibration data used to convert from raw samples to calibrated SI units

– VersionString1 Firmware version string 1

– VersionString2 Firmware version string 2

– VersionString3 Firmware version string 3

– CalibratedDataPopulated 1 for populated, 0 for unpopulated

– LocalTimeOffset Time in milliseconds to add to UTC to convert to local time

– SyncValue Dataset containing the internal sync value for each sample

* Units Attribute string containing the timestamp units (1/2560th of a second since 0:00 Jan 1, 1970 UTC)
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– Time Dataset containing a timestamp for each sample

* Units Attribute string containing the units (microseconds since 0:00 Jan 1, 1970 UTC)

– Calibrated Group containing calibrated data

* Accelerometers Dataset containing accelerometer data (Nx3)

· Units Attribute string containing the accelerometer units (m/s2)

· Range Attribute containing the range setting for the accelerometer (2g or 6g)

* Gyroscopes Dataset containing gyroscope data (Nx3)

· Units Attribute string containing the gyroscope units (rad/s)

* Magnetometers Dataset containing magnetometer data (Nx3)

· Units Attribute string containing the magnetometer units (µT)

* Temperature Dataset containing the temperature (Nx1)

· Units Attribute string containing the temperature units (◦C)

* TemperatureDerivative Dataset containing the temperature derivative (Nx1)

· Units Attribute string containing the temperature derivative units (◦C/s)

– Raw Group containing raw data if selected during import

* Accelerometers

* Gyroscopes

* Magnetometers

* DataFlags

* OptData

* Temperature

* TemperatureDerivative

14.3.4 Version 1

This version is deprecated. All new files created will use the most recent version.

• Device List Attribute containing a list of monitors present in the file

• File Format Version Attribute containing the file version

• Annotations Table containing annotations

– Time Annotation time in epoch microseconds

– Device ID A movement monitor ID associated with the annotation

– Annotation The annotation string

• Opal xxx/ Group containing information about and data from monitor ID xxx

– Sample Rate Attribute containing the output data rate for the monitor

– Decimation Factor Decimation factor for the monitor’s internal processing

– Time Good Flag indicating whether the monitor has had its time set since turning on

– Decimation Bypass Internal use, deprecated

– Calibration Version Version of the calibration data used to convert from raw samples to calibrated SI units

– Version String1 Firmware version string 1

– Version String2 Firmware version string 2

– Version String3 Firmware version string 3
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– Acceleration Dataset containing data from the accelerometers (Nx3)

* Units Attribute string containing the acceleration units (m/s2)

– Angular Velocity Dataset containing data from the gyroscopes (Nx3)

* Units Attribute string containing the angular velocity units (rad/s)

– Magnetic Field Dataset containing data from the magnetometers (Nx3)

* Units Attribute string containing the magnetic field units (a.u.)

– Temperature Dataset containing the temperature of the monitor (Nx1)

* Units Attribute string containing the temperature units (◦C)

– Temperature Derivative Dataset containing the rate of change of temperature

* Units Attribute string containing the temperature derivative units (◦C/s)

– Sync Value Dataset containing the internal timestamp of each sample

* Units Attribute string containing the timestamp units (1/2560th of a second since 0:00 Jan 1, 1970 UTC)

* Time Dataset containing the time for each sample in microseconds since 0:00 Jan 1, 1970 UTC

Additional fields present when raw data is also stored:

• Opal XX/

– Calibration Data Attribute containing binary block of calibration data

– Raw File Version Attribute containing the version string of the raw file (if this was converted from a .apdm file instead

of streamed)

– Accelerometers Raw Dataset containing raw accelerometer data (Nx3)

– Gyroscopes Raw Dataset containing raw gyroscope data (Nx3)

– Magnetometers Raw Dataset containing raw magnetometer data (Nx3)

– Data Flags Dataset containing flags used for processing the raw data

– Opt Data Dataset containing several measurements taken at a low data rate

– Temperature Raw Dataset containing lowpass filtered, but uncalibrated temperature data (Nx1)

14.4 Working with HDF 5 in MATLAB

MATLAB contains two high level functions for working with HDF5 files. Additional help and examples are

included in the built in help documentation for these functions.

hdf5info reads the structure of the file and all of the attribute values and returns them in an easy to browse

MATLAB structure.

hdf5read reads a complete dataset or attribute from the HDF5 file.

Additionally, one more high level helper function is included with the NexGen movement monitor software.

This function also contains built in help documentation and examples.

hdf5readslab reads a portion of a dataset from the HDF5 file.
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14.5 Examples

Below is simple example of loading acceleration data from an NexGen movement monitor HDF5 file (version

2 or later) in MATLAB. For version 1 files, the dataset paths simply need to be changed to match the format

listed above.

filename = 'example.h5';

try

vers = hdf5read(filename, '/FileFormatVersion');

catch

try

vers = hdf5read(filename, '/File_Format_Version');

catch

error('Couldn''t determine file format');

end

end

if vers< 2

error('This example only works with version 2 or later of the data file')

end

caseIdList = hdf5read(filename, '/CaseIdList');

groupName = caseIdList(1).data;

accPath = [groupName '/Calibrated/Accelerometers'];

fs = hdf5read(filename, [groupName '/SampleRate']);

fs = double(fs);

acc = hdf5read(filename, accPath)'; %Transposed to make Nx3 in MATLAB}

t = (1:size(acc,1))/fs;

figure;

plot(t,acc);

A more complicated example using the flexibility of HDF5 to load and process only part of a data set. This

can be useful when the data set is too large to fit into memory. Care is taken not to attempt to read beyond

the end of the file.

filename = 'example.h5';

try

vers = hdf5read(filename, '/FileFormatVersion');

catch

try

vers = hdf5read(filename, '/File_Format_Version');

catch

error('Couldn''t determine file format');

end
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end

if vers < 2

error('This example only works with version 2 or later of the data file')

end

idList = hdf5read(filename, '/CaseIdList');

groupName = idList(1).data;

accPath = [groupName '/Calibrated/Accelerometers'];

fs = hdf5read(filename, [groupName '/SampleRate']);

fs = double(fs);

fhandle = H5F.open(filename, 'H5F_ACC_RDONLY', 'H5P_DEFAULT');

dset = H5D.open(fhandle, [groupName '/Calibrated/Accelerometers'], 'H5P_DEFAULT');

dspace = H5D.get_space(dset);

[ndims, dims] = H5S.get_simple_extent_dims(dspace);

nSamples = dims(1);

nSamplesRead = min(nSamples, 60*fs); %read at most one minute of data

accSegment = hdf5readslab(filename, accPath, [0,0], [nSamplesRead, 3])';

t = (1:nSamplesRead)/fs;

figure;

plot(t,accSegment);

14.6 Notes

• Arrays in MATLAB use the FORTRAN convention of storing them in memory by column then row,

instead of the C convention (used by HDF 5) of row then column. This has the effect of making the

returned arrays transposed from how this document (and many other interfaces to HDF5) claim they

are laid out.

• Older versions of MATLAB (before 2009a) did not support the compression used in TK Motion Man-

ager’s HDF 5 files. If you are using one of these older versions, the free h5repack utility available from

the HDF Group can remove the compression. This utility is available at:

http://www.hdfgroup.org/HDF5/release/obtain5.html

The command to repack the file is:
h5repack -f NONE example.h5 example_no_compression.h5
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15 Working with CSV Files
Comma Separated Value (CSV) files are an alternate, text based format for storing NexGen movement

monitor data. The HDF format has a number of advantages, but CSV files can be opened as a standard text

file or in a spreadsheet application such as Excel or OpenOffice. This section will cover the organization of

the NexGen movement monitor data when saved to a CSV file.

15.1 File Structure

15.1.1 Version 4

CSV files are organized in a grid, where the columns are separated by commas and the rows are separated
by newlines. As with the HDF format, the CSV format can store data from multiple monitors. The columns
have the following headers:

• Metadata This column includes a number of fields describing the data in the CSV file.

– File Format Version The version of the CSV file format.

– Monitor Case IDs The case IDs of the monitors represented in the recording, separated by colons. For example

“Monitor Case IDs= :SI-000001:SI-000002”.

– Monitor Labels The labels of the monitors represented in the recording, separated by colons. For example “Monitor

Labels= :Right Leg:Left Leg”.

– Version String1 The first version string of the firmware of the first monitor in the data file.

– Version String2 The second version string of the firmware of the first monitor in the data file.

– Version String3 The third version string of the firmware of the first monitor in the data file.

– Calibration Version The version of the calibration file format of the first monitor in the data file.

• Sync Count The timestamp of each sample, in units of 1/2560th of a second since 0:00 Jan 1, 1970 UTC.

• Time The timestamp of each sample, in units of microseconds since 0:00 Jan 1, 1970 UTC.

• Button Status The state of the button for the given sample. ‘1’ indicates that it was depressed, while ‘0’ indicates that it was

released.

• Flags Flags used for processing the raw data.

• Optional Data Optional data used for processing the raw data.

• Sample Count The count of the sample, starting at 0. Unless any data was dropped, this corresponds to the row number

of the CSV file -2.

• Raw Temperature Lowpass filtered, but uncalibrated temperature data.

• Raw Acceleration X Raw, uncalibrated acceleration data.

• Raw Acceleration Y Raw, uncalibrated acceleration data.

• Raw Acceleration Z Raw, uncalibrated acceleration data.

• Raw Gyroscope X Raw, uncalibrated gyroscope data.

• Raw Gyroscope Y Raw, uncalibrated gyroscope data.

• Raw Gyroscope Z Raw, uncalibrated gyroscope data.

• Raw Magnetometer X Raw, uncalibrated magnetometer data.

• Raw Magnetometer Y Raw, uncalibrated magnetometer data.
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• Raw Magnetometer Z Raw, uncalibrated magnetometer data.

• Magnetometer Bridge Current

• Acceleration X (m/sˆ2) Calibrated acceleration data.

• Acceleration Y (m/sˆ2) Calibrated acceleration data.

• Acceleration Z (m/sˆ2) Calibrated acceleration data.

• Angular Velocity X (rad/s) Calibrated gyroscope data.

• Angular Velocity Y (rad/s) Calibrated gyroscope data.

• Angular Velocity Z (rad/s) Calibrated gyroscope data.

• Magnetic Field X (uT) Calibrated magnetometer data.

• Magnetic Field Y (uT) Calibrated magnetometer data.

• Magnetic Field Z (uT) Calibrated magnetometer data.

• Orientation Quaternion Scalar The orientation is relative to a (magnetic) north, west, up reference frame.

• Orientation Quaternion X

• Orientation Quaternion Y

• Orientation Quaternion Z

• Temperature (deg C)

If multiple monitors are included in the file, the additional columns are added to the right of the default

columns. The only column that is not repeated is the Metadata column. The monitors are represented

left-to-right in the same order as the case IDs and labels in the metadata.
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16 Working With Video
TK Motion Manager comes with the functionality to collect video that is synchronized with your inertial record-

ings. In other words, when you start/strop a recording in TK Motion Manager, the connected video camera(s)

will start/stop at the same time. Currently, two types of cameras are supported: Apple iDevices (iPhone,

iPad, and iPod) and GoPro cameras. The Apple solution is the preferred video integration for TK Motion

Manager (over the GoPro solution) because:

• More than one camera can be used at a time.

• The videos can be transferred asynchronously back to your laptop either immediately after recording or

at a later time. With the GoPro integration, you need to retrieve the files manually from the camera.

• More robust configuration options are available through TK Motion Manager by using the cameras’

browser based configuration controls.

16.1 Using Videography and Apple iDevices

The iDevices solution makes use of an app available on the Apple Store named Videography (http://

appologics.com/videography). This software must be purchased and installed on each iDevice that you

wish to use. Videography must be the open, running application on the iDevice in order for it to be triggerable.

16.1.1 Network Setup

The Videography cameras and the computer running TK Motion Manager need to be mutually reachable on

the network. There are three possible configurations:

• Common Local network: In this configuration, your computer and the Videography cameras are all

connected to the same local Wi-Fi network. Typically, this means that these devices are all on the same

subnet, meaning that the first 3 octets of the 4-octet IP addresses are the same on your computer and

all connected iDevices. For example, your computer may have the IP address 192.168.1.10 and your

cameras may have IP addresses 192.168.1.11 and 192.168.1.12. This is the easiest setup to use, as

your devices maintain internet access to the outside world through the standard internet connection.

• Ad-hoc network: In this configuration, you create an ad-hoc network on your computer running TK

Motion Manager and connect each Videography camera to this network individually. In this mode,

your computer running TK Motion Manager and the Videography cameras may not have access to

the internet, unless you configure your computer to use a different network connection while its Wi-Fi

adapter is being used for the ad-hoc network (e.g., you can use Ethernet for your internet connection

and the ad-hoc Wi-Fi network for camera control). This option is useful when no other Wi-Fi network is

available.
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• Different Wi-Fi networks: Even if the laptop and your Videography cameras are on different networks,

such as two different Wi-Fi access points within one clinic or two computers in different cities, it may still

be possible to remotely control them. The key requirement is that the IP address of the Videography

cameras is reachable on port 80 (the standard web port). This may, however, require some advanced

networking practices, such as port forwarding.

16.1.2 Camera Configuration

• Enable the use of Videography cameras:

– Click View→Options in the File Menu.

– Select ”Enable Videography video integration”

– Click ”Done” and restart the application

The Videography Camera Configuration Dialog

• Click Video→”Manage Videography Cameras”. You will see a configuration dialog similar to the one

above.

• If your computer and all Videography cameras are on the same Wi-Fi network, you can use the Auto-

Detect Cameras feature to automatically find and add your Videography cameras. Please note that

this takes 20s or so. Alternately, you can add the IP address of each camera individually in the text field

at the top and clicking on the ”Add Camera at http://” button. Note: You can determine the IP address

of the Videography camera by clicking on Settings→”Remote Control” and looking at the Wi-Fi address

field.

• If you wish to configure your camera, select it in the dropdown list and click the Configure button.

Note: You can access the same configuration dialog through a web browser by entering the camera’s

IP address into the browser’s address field or by using the software’s configuration options directly

through the iDevice.

• You can select the Automatically Transfer Video option if you want video to be transferred back to

your computer immediately following the video capture. Due to the potentially large size of the video
51



16 Working With Video

files, you may want to avoid this if you are collecting long video segments with brief periods of inactivity

between them or if your network speeds are slow, as active video transfers may interfere with an active

recording session. Videos can easily be transferred using the video management tool at a later time.

• If a Videography camera is listed here that you no longer wish to trigger, select it and click the Remove

button.

16.1.3 Triggering The Camera

• When you open up the recording dialog, a Videography widget will be visible among the recording

controls. This widget will indicate how many cameras are configured for recording. Communication

with each configured camera is checked when the recording dialog is opened, so it is possible that one

or more expected cameras do not appear on this list if they are experiencing network issues, have shut

down, have switched to another application, etc. If the list doesn’t match up with your expectations,

click on the Videography icon within this widget to re-open the configuration dialog.

• When you start an inertial recording from within TK Motion Manager, the camera(s) will start recording

(each camera will display on its own screen that it is recording). When you hit stop, the camera will stop

recording.

• If you have the ”Automatically Transfer Videos?” option set, the video will be transferred to the computer

running TK Motion Manager. If not, you can use the Video Manager to transfer and view these files at

a later time.

16.1.4 Managing Videography Videos

All recorded Videography videos will be logged in the Video Management Tool. This tool will help you

keep track of when the recordings were made, which inertial recordings they are associated with, properties

of each video (e.g., resolution, size), and whether the video has been transferred from the camera to your

computer yet.

• The videos will end up in the following folder:

INSTALL FOLDER\Mobility Lab\workspace\CURRENT PROJECT FOLDER\videos

If you are using Mobility Lab, the CURRENT PROJECT FOLDER is named ”MobilityLabProject”

• Video Properties:

– Time of Recording: The time when both the inertial and video recording were initiated.

– Duration: The duration of the recording

– Resolution: The video resolution

– Size: The disk size of the video recording

– Camera: The name of the iDevice running Videography.

– File name: The name of the video file after it has been transferred. This matches the name of the
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The Video Management Tool

recorded inertial file, with an addition to identify the source camera (needed if multiple cameras

are used for simultaneous video).

– Retrieved: Whether the video has been transferred from the remote camera to your computer yet.

• Actions

– Transfer Selected: Transfer any selected videos from the remote camera to your computer. The

iDevices that you are transferring the videos from must all be running Videography and must be

connected through the use of the Camera Configuration Dialog. You can click on the ”Manage

Cameras” button on the bottom of the dialog to open up the Camera Configuration Dialog.

– Transfer Untransferred: Transfer any videos that have not yet been retrieved.

– Remove Selected: Remove the selected video(s) from the video log.

– Play Video: Play the selected video. This function only works if the video has already been

transferred.

• Note: We do not currently have a tool to view raw inertial data along side the video(s), but this is planned

for a future release. These videos should be playable on any modern computer. If you have issues with

playback, try downloading VLC (http://www.videolan.org/vlc/index.html)

16.1.5 Synchronization Performance

We have measured the following characteristics regarding synchronization between the video and inertial

recordings:
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• Mean synchronization error : 100ms

• Standard deviation of the synchronization error: 80ms

• Max synchronization error: 250ms

This variability comes from the communication overhead and when the iDevice actually starts recording. This

should be sufficient for most types of recordings, but may be slightly inaccurate when looking at very fast or

brief actions.

16.2 Using a GoPro Camera

Our integration with GoPro cameras is not as robust as the Videography integration due to limitations of

the camera and network design. GoPro also does not provide official support for external control of their

cameras, so our GoPro support may unexpectedly stop in the future. Due to the ubiquity of these cameras,

however, we will do our best to support the remote triggering of GoPro cameras.

The GoPro Configuration Dialog

16.2.1 Network Setup

• The GoPro camera must either be a Hero 2 camera with the Wi-Fi bacpac add-on, or a Hero 3 camera

with integrated Wi-Fi bacpac.
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• Your computer running TK Motion Manager must have a Wi-Fi adapter.

• Connect your computer to the GoPro’s Wi-Fi access point, as you would any other Wi-Fi access point.

The default wireless password is ”goprohero”. If this has been changed, it needs to be changed back

to this default value.

16.2.2 Camera Configuration

• Enable the use of a GoPro camera:

– Click View→Options in the File Menu.

– Select ”Enable GoPro video integration”

– Click ”Done” and restart the application

• Go to the Video→GoPro option in the menu bar. This should communicate with the GoPro and retrieve

a subset of the camera settings for display.

• Assuming the connection went correctly, you can set the resolution and framerate from this display and

test triggering the start/stop functionality. There is also a checkbox ”Trigger Camera When Record-

ing”. If this is checked, the camera will automatically start and stop when you start and stop wireless

recording from within TK Motion Manager.

• Other configuration options need to be set from within the camera itself.
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17 Powering Your Monitors On and Off

17.1 Docking Monitors

In most situations, it is sufficient to simply dock your monitors when not in use. When docked, monitors stop

recording, stop broadcasting, and start charging their batteries. Once fully charged, the batteries will enter a

trickle charge mode to keep them topped off.

The power buttons in the toolbar

17.2 Power Off

For transport or storage, it is often desirable to power off all system components. This can be done by

docking the monitors and clicking on the “Power Off” button in the toolbar. When this option is chosen, the

monitors will power down the next time they are undocked.

Alternately, you can configure your monitor to power down or standby when it is rapidly spun about the z-axis

(see Section 7.2.2 for details).

17.3 Power On

From a powered off state, the monitors can be powered on by either configuring them by re-applying your

previous configuration or creating a new one through the Configuration Status Tool (see Section 7.1 for

details).
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18 Firmware Updates
Firmware controls the various hardware components of your I2M product line (monitors, access points, and

docking stations). It is important to keep the firmware up to date to ensure that your system gets the latest

bug fixes and has access to the latest features. Firmware updates are bundled with updates to TK Motion

Manager. Firmware can be updated either automatically or manually.

18.1 Automatic Firmware Updates

Whenever you configure your system, your hardware is first checked to ensure that the latest firmware is

installed. If not, you will be prompted to automatically update your hardware to the latest versions of the

firmware bundled with your system.

18.2 Manual Firmware Updates

Firmware can be updated manually as well. This functionality can be used to either flash the default firmware

to one of the hardware components, or to flash a different version. To access the “Update Firmware” dialog,

click on “Tools→ Update Firmware” in the menu bar.

The manual firmware update tool

18.2.1 Flash Default Firmware

Your system comes bundled with an up to date version of the firmware. Pressing this button will re-flash this

version of the firmware onto the specified monitor.

18.2.2 Flash Alternate Firmware

For testing purposes or to address an issue in a timely fashion, it may be necessary to flash a monitor with

a version of the firmware that is different than the bundled version. You will have to specify the alternate

firmware file to use with this option.
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18.2.3 Force Update

When using either of the options above, if the firmware version on the target device(s) matches the firmware

version to be flashed, the device will be skipped. If the “Force update even if versions match” checkbox is

selected, however, the firmware will be flashed even if the versions match. This may be necessary in some

cases to recover a malfunctioning device.
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19 Calibration

19.1 Sensor Error Models

The errors modeled and compensated for by the calibration are: scale factor, cross axis sensitivity, sen-

sor misalignment, and bias. For scale factor, there is a linear temperature model, and for bias, a look up

table based temperature model. The notation is reused, but each type of sensor has distinct calibration

parameters. For example, the scale factor matrix S T for the accelerometers is different from the one for the

gyroscopes, and from the one used for the magnetometers. NexGen factory calibration does not compensate

for misalignment between the sensors and the case, only misalignment between the accelerometers and the

other two sensors.

19.1.1 Accelerometers

The calibrated accelerometer measurements are calculated as

~acal = CS T (~araw − ~bT )

C =


cos sxy cos sxz sin sxy sin sxz

sin sxy cos sxy cos syz sin syz

sin sxz sin syz cos sxz cos syz


S T =


sx + T sx,T 0 0

0 sy + T sy,T 0
0 0 sz + T sz,T


~bT =


bx,T

by,T

bz,T


where C is the cross axis sensitivity matrix, S T is the temperature dependent scale factor matrix, and ~bT is

the temperature dependent bias vector. There is a look up table for the temperature effect on bias for each

sensor axis. The bias value for a particular temperature is linearly interpolated from this table.
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19.1.2 Gyroscopes

The calibrated gyroscope measurements are calculated as

~ωcal = MCS T (~ωraw − ~bT )

M =


1 0 0
0 cos θr − sin θr

0 sin θr cos θr




cos θp 0 sin θp

0 1 0
− sin θp 0 cos θp




cos θy sin θy 0
− sin θy cos θy 0

0 0 1


C =


cos sxy cos sxz sin sxy sin sxz

sin sxy cos sxy cos syz sin syz

sin sxz sin syz cos sxz cos syz


S T =


sx + T sx,T 0 0

0 sy + T sy,T 0
0 0 sz + T sz,T


~bT =


bx,T

by,T

bz,T


where M is the misalignment matrix, C is the cross axis sensitivity matrix, S T is the temperature dependent

scale factor matrix, and ~bT is the temperature dependent bias vector. There is a look up table for the temper-

ature effect on bias for each sensor axis. The bias value for a particular temperature is linearly interpolated

from this table.
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19.1.3 Magnetometers

The calibrated magnetometer measurements are calculated as

~mcal = MCS T (~mraw − ~bT )

M =


1 0 0
0 cos θr − sin θr

0 sin θr cos θr




cos θp 0 sin θp

0 1 0
− sin θp 0 cos θp




cos θy sin θy 0
− sin θy cos θy 0

0 0 1


C =


cos sxy cos sxz sin sxy sin sxz

sin sxy cos sxy cos syz sin syz

sin sxz sin syz cos sxz cos syz


S T =


sx + T sx,T 0 0

0 sy + T sy,T 0
0 0 sz + T sz,T


~bT =


bx,T

by,T

bz,T


where M is the misalignment matrix, C is the cross axis sensitivity matrix, S T is the temperature dependent

scale factor matrix, and ~bT is the temperature dependent bias vector. There is a look up table for the temper-

ature effect on bias for each sensor axis. The bias value for a particular temperature is linearly interpolated

from this table.

19.1.4 Temperature

The calibrated temperature measurements are calculated as

Tc = s(Tr − b20) + 20,

where s is the scale factor, Tr is the raw sensor reading, and b20 is the raw temperature value at 20 degrees

Celsius.

19.2 Factory Calibration

Your monitors come pre-calibrated from NexGen. Each monitor is calibrated individually in a procedure

that determines optimal scaling factors and offsets for the accelerometers, gyroscopes, and magnetometers

across a wide range of orientations and temperatures.
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19.2.1 Updating Factory Calibration

There may be rare cases where the factory calibration data is deleted from your monitor(s) due to an issue

with the SD card. In these scenarios, it may be necessary to re-flash the factory calibration onto your monitor

using the “Flash Factory Calibration” button in the monitor tab of the configuration dialog. If you believe that

you have a poorly calibrated monitor and would like to discuss your options, contact our support team using

the contact information provided in Section 25.

19.3 User Calibration

While the factory calibration is optimal at the time of shipping, all low power sensors like the ones used in

NexGen’s monitor’s are subject to small changes over time and may require re-calibration. This is something

that can be done by NexGen, but we are also dedicated to providing tools to enable end users to recalibrate

their own devices.

19.3.1 Magnetometer Recalibration

To perform this task, click on the “Tools”→“Recalibrate Magnetometer” option in the menu bar. This wizard

will guide you through the process of recalibrating the magnetometers on your monitor(s). The wizard asks

that you only undock and collect calibration data one monitor at a time, because they must each be moved

independently away from other objects that may disrupt the magnetic field (including other monitors).

19.3.2 Gyroscope Recalibration

To perform this task, click on the “Tools”→“Recalibrate Gyroscopes” option in the menu bar. This wizard

will guide you through the process of recalibrating the gyroscopes on your monitor(s). This process can be

applied to all of your monitors simultaneously.

19.3.3 Accelerometer Recalibration

Coming soon!

19.4 Clearing User Calibration

If you wish to revert to the factory calibration settings, you can clear any user calibration that you have applied.

This can be accomplished through the “Clear User Calibration” button in the monitor tab of the configuration

dialog.
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20 External Synchronization and I/O
The access point comes with external connectors that enable you to synchronize the recording of data in

TK Motion Manager with external equipment. This functionality only works when the system is configured in

one of the wireless streaming modes and the “Stream” dialog is open. The implementation is adaptable to a

number of scenarios. Here are some examples of things you can do:

• Trigger recording in TK Motion Manager when external events occur. You can use this functionality to

precisely synchronize your inertial recordings with, for example, recordings initiated on a camera based

motion capture system.

• Trigger external events when you start and stop recording in TK Motion Manager. You can use this

functionality to precisely synchronize your inertial recordings initiated in TK Motion Manager with, to

use another example, a video recording system.

• A combination of the two. For example, hitting the record button on a camera based motion capture

system could trigger recording in TK Motion Manager which could then trigger a video recording system.

The External Synchronization Configuration Dialog
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20.1 Configuration

Specification of external synchronization options is performed through the External Synchronization Con-

figuration dialog. If multiple access points are being used, synchronization options are specified for each

access point individually so that you can determine which ones are receiving external signals and/or sending

external signals. Each access point can have its input and output triggers specified individually. Input and

output triggers can also be disabled through the configuration dialog.

20.2 Input Synchronization

Input synchronization trigger types

20.2.1 Input Trigger Shape

The input trigger shape indicates the type of signal that will be input into the specified access point and how

you want TK Motion Manager to respond when using the “Stream” dialog. In the figure above, the four basic

trigger shapes are shown. The solid black line represents the external synchronization signal being sent to

the access point. The blue shaded region represents the period that will be recorded in TK Motion Manager.

Input triggers are only processed when the “External Sync” option is specified in the “Record Duration” panel

of the “Stream” dialog.

20.2.2 Input Trigger Level

Input triggers can be either low or high, depending on the nature of the signal generated by your external

synchronization source.
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20.2.3 Input Trigger

There are three input trigger options available:

• Start: The external trigger will only be used to start recording in TK Motion Manager.

• End: The external trigger will only be used to stop recording in TK Motion Manager.

• Both: The external trigger will be used to start and stop recording in TK Motion Manager.

20.2.4 Sample Selection with External Input Trigger Events

The time of the external input trigger events may not align exactly with the time of an individual samples

being collected in TK Motion Manager due to the discreet sampling interval. If the start trigger event time

does happen to align exactly with a sample captured in TK Motion Manager, the first sample recorded will

correspond exactly to the time of the start trigger event. If these do not align exactly (as will generally be

the case) the sample preceding the start trigger event will be the first sample recorded. Similarly, if the stop

trigger event aligns exactly with a sample captured in TK Motion Manager, the last sample recorded will

correspond exactly to the time of the stop trigger event. If these do not align exactly, the sample following the

start trigger event will be the last sample recorded. This way, we guarantee that the recording captured in TK

Motion Manager fully spans the time period between the external input start and stop events, but no more.

20.2.5 Annotation of Externally Triggered Recordings

Note: Annotations are implemented for the HDF file format only. When an external “Start” trigger event is

detected, an annotation is added to the recording that indicates the name of the event (in this case “External

trigger start time”) along with the timestamp of the event in epoch microseconds. Similarly, when an external

“Stop” trigger event is detected, a timestamped annotation is added to the recording (in this case labeled as

the “External trigger stop time”). These annotations allow you to align the recording captured in TK Motion

Manager with your external events in the case where the external trigger event times do not exactly align with

the samples captured in your HDF file.

20.3 Output Synchronization

20.3.1 Output Trigger Shape

The output trigger shape indicates the type of signal that will be generated by the specified access point

when recording is started and stopped through the streaming dialog in TK Motion Manager. The output

trigger shapes are identical to the input trigger shapes, but in this case the solid black line in the figure above

represents the signal being output by the configured access point. The blue shaded region represents the
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Output synchronization trigger types

period being recorded in TK Motion Manager, initiated either through user selection of the start/stop buttons

in the “Stream” dialog, use of the wireless remote, or an external synchronization event. Unlike input triggers,

output triggers are processed even if the “External Sync” option is not specified in the “Record Duration” panel

of the “Stream” dialog.

20.3.2 Output Trigger Level

Output triggers can be either low or high, depending on the requirements of the external system receiving

the synchronization signal.

20.3.3 Output Trigger

There are three output trigger options available:

• Start: The external signal will only be generated when recording is started in TK Motion Manager.

• End: The external signal will only be generated when recording is stopped in TK Motion Manager.

• Both: The external signal will be generated when recording is started and stopped in TK Motion Man-

ager.

• Note: It is not recommended to use the level trigger shapes in conjunction with the start or end triggers.

This is because the output signal will be in an undeterministic state prior to the trigger event.

20.4 Isolated External Interface Details

NexGen’s access points come fitted with a 6 pin digital I/O connector and a 4 pin analog I/O connector.

To connect an access point to your external equipment, you may have to create a custom cable that can

interface with both components. Below we provide the technical specifications necessary to complete this

task. Feel free to contact our technical support at techsupport@nexgenergo.com if you require assistance or
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have additional questions.

The Isolated External Interface for the AP consists of an auxiliary power supply, two GPIO lines (one in, one

out), and an inter-AP sync signal. All signals in the isolated external interface section (including power and

ground) are isolated from the remainder of the board using an RF solution similar in operation to an opto-

isolator. Further, all signals in the isolated external interface are 5V tolerant and ESD protected beyond the

15kV human body model.

The connectors used in the isolated interface consist of one standard female RCA, and one female 6 pin

mini-din connector. The RCA connector mates to almost any basic RCA cable similar to those used in audio

systems. When choosing an RCA mating connector, choose one that has uncovered bare shield spades to

allow the connector to fit fully into the recessed hollow in the AP body.

The 6 pin mini-din connector is similar to those used for older style PS/2 keyboards and mice. Choose a

connector that is small enough to fit fully inside the recessed hollow in the AP body. Some PS/2 extension

cables can be cut into excellent pigtails for this connector.

20.4.1 RCA Inter-AP Sync Connector

• RCA Connector: Digikey Part number RCP-021, CUI INC

• Center Pin: Inter-AP Sync

• Sheild: Isolated Ground

20.4.2 6 Pin Digital Input/Output Connector

• 6 Pin Mating Connector: Digikey part number CP-2060-ND, CUI Inc part number MD-60.

• 6 Pin Mating Pig Tail Cable: Digikey part number 839-1051-ND

• Note these connectors may need the outer shell trimmed to fit into the AP case, a better solution is

often pigtail cables that have over-molded ends and excellent strain relief.

AP 6 Pin Digital Connector
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• Pin 1: Record In

• Pin 2: Output Voltage Select. When connected to positive (pin 6), I/O will be in 5 volt mode. 3.3 volt

mode otherwise.

• Pin 3: Isolated Ground (isolated gnd)

• Pin 4: Inter-AP synchronization output signal. 2.56 khz square wave used for synchronizing timing

among multiple access points.

• Pin 5: Record Out

• Pin 6: Isolated Vdd, unregulated. 3.3 V or 5 V depending on whether it is connected to pin 2.

The auxiliary power supply is meant to provide for powered external interface solutions, allowing a small

circuit to be powered directly from the AP. Accessed via pin 6 of the mini-din connector, the auxiliary power

supply is rated for operation up to 250mW at 3.3V or 5V operation. While default operation is at 3.3V, 5V

operation can be selected by shorting pin 2 to pin 6 of the 6 pin mini-din connector.

The inter-AP sync signal is a 2.56kHz clock signal used to keep multiple AP configurations in sync with one

another. The inter-AP sync signal is available on the RCA connector, as well as pin 4 of the 6 pin mini-din

connector next to it. The signal is a square wave pulse that is driven by the ’master’ AP (usually the first AP

to enumerate) and received by up to seven additional APs (depending on output voltage selection and cable

length). In operation the signal is weakly pulled up to the isolated power rail by each AP in the system, and

driven directly to ground only by the ’master’ AP to produce the pulsed waveform.

Two GPIO lines are available, one input and one output. Both are pulled down by 47.5kΩ resistors, and

each have a series resistance of nearly 1.2kΩ due to the methods used to protect the lines from over-

voltage/overcurrent conditions. The input signal is available on pin 1 of the 6 pin mini-din connector and

is typically used to start/stop data collection by the host PC. Driving the line high to ’record’ and low to

’not-record’ is the default operation, though this is user selectable in software to allow for other modes of

operation. Similar to the input line, the output line is typically used to start/stop data capture on external

systems. The line is driven high by the AP when ’start recording’ is selected in software, and driven low when

recording stops. Opposite high/low operation can be software selected at time of configuration for both input

and output signals.

• Note: The pin diagrams below show the interface on the AP and not the cable. The pin layout on the

cable is the mirror image of these diagrams.

• Note: A cable designed to trigger recording in TK Motion Manager from an external synchronization

event must make use of isolated ground (pin 3) and record in (pin 1). Assuming a voltage range of 3.3V,

these are the only pins that need to be implemented. If the voltage range is 5V, pins 2 and 6 must be

connected.

• Note: A cable designed to trigger an external system when recording is started or stopped in TK Motion

Manager must make use of isolated ground (pin 3) and record out (pin 5). Assuming a voltage range of
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3.3V, these are the only pins that need to be implemented. If the voltage range is 5V, pins 2 and 6 must

be connected.

20.4.3 External Sync Box

The external sync box is meant to allow for easy access to the access point external digital expansion port.

A shielded straight-through six conductor cable connects the AP to the sync box, BNC connections outside

the box allow for simple connections to remote equipment.

AP External Sync Box

Three external BNC connections:

• AP-AP: This connection should only be connected to another AP, it is used to keep multiple APs in sync

and can be used to connect multiple APs in a star or daisy chain configuration (both will work).

• AP In: This input to the AP can be configured via software to allow an external device to begin and stop

recordings. Accepts both +3.3V and +5V logic levels.

• AP Out: This AP output can be configured via software to drive low, high, or pulse at record start/stop

points allowing synchronization with an external system (such as a camera motion capture system).

Note: the default configuration for AP Out is +3.3V logic levels, though +5V levels can be selected

using the voltage select switch located in the top of the box.

Four LEDs indicators:

• PWR: Lights when power is applied to the external interface.

• +5V: Lights to indicate that the external interface is configured for 5V operation. Default is 3.3V (Light

out)

• AP In: Lights to indicate that the APlIn signal is High

• AP Out: Lights to indicate that the AP Out signal is High

Push-button and Toggle switch:
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20 External Synchronization and I/O

• Push Button: Up to select 3.3V operation. Down to select 5V operation.

• Toggle: Manually ties the AP In signal to the positive voltage rail allowing for manual triggering of

recordings (software configured).

Additional connections and functionality are located inside the box and can be accessed by removal of the

box top: JP1 through JP4 can be removed to disconnect the corresponding LED.

Six Euro-style screw terminals can be used to directly connect to the six wires in the AP cable:

AP External Sync Box

• +V: Positive voltage rail from the isolated supply located inside the AP.

• GND: Ground rail from the isolated supply located inside the AP.

• VSEL: Tie to Ground or leave floating to select output and +V operation at +3.3V, tie to +V to select +5V

operation.

• AP-AP: Allows multiple AP configurations, tie only to the same port of another AP.

• AP Out: Digital output from the AP. Default is 0V to +3.3V, but can be configured for 0-5V operation.

• AP In: Digital input to the AP from an external source or the manual trigger toggle switch.

Note: The AP is able to safely source only 50mA on the +V rail.
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20 External Synchronization and I/O

20.4.4 4 Pin Analog Input/Output Connector

Note: This connector is currently reserved for future expansion.

• 4 Pin Mating Connector: Digikey part number CP-2040-ND, CUI Inc part number MD-40

• 4 Pin Mating Pig Tail Cable: Digikey part number 839-1049-ND

AP 4 Pin Analog Connector

• Pin 1: Analog In (0 to 6 volts)

• Pin 2: Analog Out (0 to 5 volts or 0 to 3.3 volts depending on software controled configuration)

• Pin 3: No Connect (reserved for future use, avoid connecting this pin)

• Pin 4: Ground (gnd). This is the same ground as USB, and depending on how your USB hub and/or

laptop are designed electrically, may also be the same ground as the hub and laptop. Consideration

should be taken for ground loops.

20.4.5 Schematic
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21 Monitor Reference

21.1 Charging

A movement monitor charges its internal battery any time it is connected to a docking station. At the optimal

charge rate the movement monitors internal battery will complete its bulk charge (80%-90%) within an hour

for a fully discharged battery. It is recommended that the movement monitor be charged for up to 3 hours to

provide a peak charge to the battery ensuring it has the longest run time and improves battery life.

Warning: Your movement monitor uses a lithium battery. This battery may only be charged over a limited

temperature range. Never attempt to dock or charge your Opal when the temperature experienced can be

outside the range of 0 to 45 degrees Celsius (32 to 113 degrees Fahrenheit). The recommended charging

and docking temperature range is between 5 to 35 degrees Celsius (40 to 95 degrees Fahrenheit).

21.2 Powering Down

If you wish to power down your monitors for storage or travel, dock the monitors you wish to power down and

click on the “Power Off” button in TK Motion Manager. After this process is complete, these monitors will

power down when they are undocked. They can be powered back on by re-applying the saved configuration

or re-configuring the system.

21.3 Data Storage

The movement monitors utilize a flash card to store data while logging. This data can be downloaded by

using a docking station to dock the movement monitor. When the movement monitor is docked it finishes up

writing to the internal flash card and then releases it to the docking station. At this time the docking station

indicates to the PC that there is a new read only removable drive to be mounted. Using your file browser

you can navigate to the removable drive and copy the files off of it. The files are in a proprietary raw format

and need to be converted to either a HDF5 or CSV format that will provide data in calibrated SI units. This

conversion happens automatically if TK Motion Manageris used to import the data. Alternately, there are

functions in the SDK to do this conversion programmatically.

21.4 Cleaning

Cleaning the movement monitors case should be done by wiping the bottom of the case where it contacts

the skin with Rubbing alcohol or other cleaning wipe. If the entire case needs to be cleaned use only an ethyl

alcohol or isopropyl alcohol based wipe. Methyl alcohol should be avoided for cleaning the top since it will
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cause degradation of the plastic over time. The movement monitor should not be submerged in any liquids or

subjected to any high temperatures for cleaning. The straps on the monitor can be cleaned by wiping them

down with Rubbing alcohol. Alternatively the straps can be removed and washed separately using mild soap

and water.

21.5 Storage

Storage of the movement monitor should be in a dry static fee location. An anti-static bag or in the supplied

case is recommended. The movement monitor should also not be subjected to any large G forces to prevent

damage or changes to the calibration of the sensors in the monitor. It is recommended for the health of the

battery to to have at least a bulk charge during storage.

21.6 Drivers

Drivers are provided as part of the library distribution and TK Motion Manager. The drivers are installed

automatically as part of the TK Motion Manager installation process.

21.7 Firmware Updates

Updating the movement monitor firmware should be done using the TK Motion Manager software. This

process is detailed in Section 9 of this document.

21.8 Technical Specifications

• The accelerometer range is ±58.8 m/ s2 (6 g) (optionally ±19.6 m/ s2 (2 g)).

• Accelerometers have a typical noise density of 1.3 mm/ s2/
√

Hz.

• The X and Y axis gyros have a range of ±34.9 rad/s (2000 dps)

• The Z axis gyro has a range of ±26.8 rad/s (1500 dps)

• The X and Y axis gyros have a typical noise density of 0.81 mrad/ s/
√

Hz

• The Z axis gyro have a typical noise density of 2.2 mrad/ s/
√

Hz

• Magnetometers have a range of ±6 Gauss

• The magnetometers have a typical noise density is 160 nT/
√

Hz

• Positive X is pointing from the monitor toward the connector. Looking top down at the monitor with

positive X pointing away from you, positive Y is pointing left. Z is pointing up out of the top of the case.

Angular velocity sign is defined according to a right hand rule. A counterclockwise rotation about the Z

axis looking from the +Z direction is positive.
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21.9 LED Reference

21.9.1 Status Codes and LED Colors/Patterns

The LEDs on the access points and movement monitors provide important information about the operating

state of the hardware, including error statuses. The tables below list the LED patterns associated with these

states and can be useful in troubleshooting issues encountered with the hardware.

21.9.2 Movement Monitor LED Reference

Movement monitors contain a RGB LED capable of outputting a wide array of colors to the user to indicate

its current state. The following colors are used: white (�), red (�), yellow (�), green (�), cyan (�), blue (�),

magenta (�), and led off ( ). In the off state the LED will appear as a non illuminated white dot in the corner

of the monitor opposite the docking connector. All LED patterns are output on a repeating cycle which may

vary in period depending on the pattern. In all cases the last color listed will stay constant until the pattern

repeats. For example “� � ” will blink yellow twice and then stay off until the pattern repeats.
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State LED Pattern

Startup Mode (boot loader)

Startup wait (5 sec) v1.0, bootloader v1 �

Startup wait (5 sec) v1.1, bootloader v2 �

Failed to load firmware �

Boot loader mode �

Firmware Mode

Docked mode (pre-charging – very low battery) ��

Docked mode (bulk charging – low battery) ��(fast)

Docked mode (trickle charging – 80-100% charge) ��(slow)

Docked mode (full charge) �

Docked mode (battery error) ��

Docked mode (wait) �

Docked mode (error) � � �

Reset mode �

Transitioning into standby or powering off �

Hold mode �

Run mode (battery level 4, full) � � � �

Run mode (battery level 3) � � �

Run mode (battery level 2) � �

Run mode (battery level 1, low) �

Run mode (battery very low) � � �

Run mode (clock unset, battery level 4, full) � � � � �

Run mode (clock unset, battery level 3) � � � �

Run mode (clock unset, battery level 2) � � �

Run mode (clock unset, battery level 1, low) � �

Run mode (clock unset, battery very low) � � � �

Run mode (no sync-lock, battery level 4, full) � � � � �

Run mode (no sync-lock, battery level 3) � � � �

Run mode (no sync-lock, battery level 2) � � �

Run mode (no sync-lock, battery level 1, low) � �

Run mode (no sync-lock, battery very low) � � � �

Run mode (clock unset, no sync-lock, battery level 4, full) � � � � � �

Run mode (clock unset, no sync-lock, battery level 3) � � � � �

Run mode (clock unset, no sync-lock, battery level 2) � � � �

Run mode (clock unset, no sync-lock, battery level 1, low) � � �

Run mode (clock unset, no sync-lock, battery very low) � � � � �
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State LED Pattern

Error Modes

Error mode: default � �

Error mode: configuration � � �

Error mode: system � � � �

Error mode: data buffer � � � � �

Error mode: SD buffer � � � � � �

Error mode: SD I/O � � � � � � �

Card is full �

Wireless Streaming Debug LED Modes

Normal �

CPU limited ��

Sync bad ��

CPU limited, Sync bad ��

Missed sync > 0 �

Missed sync > 0, CPU limited ��

Missed sync > 0, Sync bad ��

Missed sync > 0, CPU limited, Sync bad ��
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21.10 Technical Drawing
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22 Access Point Reference

22.1 Drivers

Drivers are provided as part of the SDK distribution and TK Motion Manager.

22.2 Firmware Updates

Updating the movement monitor firmware should be done using the TK Motion Manager software.

22.3 Mounting and Placement

The antennas of the access point are located directly behind the black plastic face of the access point. The

access point(s) should be aimed such that this face is in the approximate direction of the area where the

movement monitors will be used.

22.4 Using Multiple Access Points

Having multiple access points is useful when redundancy is needed or when recording from more than 6

SXTs. To configure multiple access points, you must have them attached to your computer via USB at the

time of configuration. Additionally, the access points must be linked via RCA cable (a standard stereo cable).

The rest of the configuration is handled automatically.

22.4.1 Redundancy

In some recording environments, it may be difficult to always maintain line of site from your streaming SXTs

to the access point. For example, you may have a bend in a hallway, or you may be operating in a large open

space where you are unlikely to receive a reflected signal if the SXT is pointed away from the access point.

In these scenarios, multiple access points can be used to provide better coverage. The streaming SXTs will

communicate with whichever access point is providing the stronger signal.

22.4.2 Streaming from more than 6 SXTs

Each access point can communicate with up to 6 SXTs simultaneously. You can therefore stream from up to

12 SXTs with 2 access points, or 24 SXTs with 4 access points.
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22.5 LED Reference

Access points contain a RGB LED capable of outputting a wide array of colors to the user to indicate its

current state. The following colors are used: white (�), red (�), yellow (�), green (�), cyan (�), blue (�),

magenta (�), and led off ( ). All LED patterns are output on a repeating cycle which may vary in period

depending on the pattern. In all cases the last color listed will stay constant until the pattern repeats. For

example “� � ” will blink yellow twice and then stay off until the pattern repeats.

State LED Pattern

Access point is powered on and is not receiving data from any monitors �

Access point is receiving data from all monitors and there is no excessive latency for

any of the monitors

�

Access point is receiving data from all monitors but there is excessive latency (>3s) in

one or more monitors. The latency is, however, decreasing (improving). This usually

indicates that one or more monitors was temporarily obstructed and is now catching

up.

��

Access point is receiving data from all monitors but there is excessive latency (>3s) in

one or more monitors which is increasing (getting worse). This usually indicates that

one or more monitors is obstructed and is having trouble transmitting its data.

��

Access point is receiving data from one or more, but not all, of the movement monitors �

Access point is receiving data from one or more monitors that it is not expecting to re-

ceive data (e.g. there is a monitor configured on another computer system streaming

data)

�� or ��

Access point is in low power USB suspend mode. �

Access point firmware error type 3, contact support � � �

Access point firmware error type 4, contact support � � � �

Access point firmware error type 5, contact support � � � � �

Access point SDRAM Memory error, contact support � � � � � � � �

22.6 Mechanical and Electrical Specifications

Weight: 1.2lbs, (550 grams)

Electrical: 290mA at 5V over USB connection
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22.7 Technical Drawing
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23 Docking Station Reference

23.1 Drivers

Drivers are provided as part of the SDK distribution and TK Motion Manager.

23.2 Power

• If running a single docking station, it can be powered from:

– a USB cable plugged into a dedicated USB port on your computer

– a USB cable plugged into a a powered USB hub

– a USB cable plugged into a wall adapter (charging only)

– the external AC adapter (charging only)

• If running a chain of 2 or more docking stations:

– For data transfer, both USB and external AC power are required. If a power-related error occurs,

then the docking station will blink yellow until external or power is plugged in.

– if only charging is required, the external AC power must be used

23.3 Mechanical and Electrical Specifications

Weight: 0.2 lbs, (90 grams)

Electrical: 500mA at 5V over USB connection, or 500mA per dock when a chain is supplied by external

power.
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23.4 LED Reference

Docking stations contain a RGB LED capable of outputting a wide array of colors to the user to indicate its

current state. The following colors are used: white (�), red (�), yellow (�), green (�), cyan (�), blue (�),

magenta (�), and led off ( ). All LED patterns are output on a repeating cycle which may vary in period

depending on the pattern. In all cases the last color listed will stay constant until the pattern repeats. For

example “� � ” will blink yellow twice and then stay off until the pattern repeats.

State LED Pattern

OK �

Powered off, USB suspended, or booloader pause �

OK, but USB not enumerated �

Power problem. Need to plug in external power or USB

power.

�

Docking in progress �

Docked, but SD unavailable to host �

SD Card mounting in progress � �

SD Card mounted and avaliable to host �

SD card read-access in progress �

USB error �

Error �

Error: SD card mounting error � �

Error: in-dock USB hub problem � � �

Firmware error type 4, contact support � � � �

Firmware error type 5, contact support � � � � �

Firmware error type 6, contact support � � � � � �

Bootloader mode �

Updating firmware �

Hardware Error - DA � � � � � �

Hardware Error - GA � � � � � �

Hardware Error - PA � � � � � �

Hardware Error - UA � � � � � �
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23.5 Technical Drawing
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24 Limited Warranty
This Limited Warranty applies to the I2M equipment and does not apply to related software. All software

is covered by the End-User License Agreement. I2Mequipment is covered by the one-year parts & labor

warranty which is void should the customer open the equipment without written authorization or due to

misuse.

1. Warranty of Title. NEXGEN ERGONOMICS Inc. (“NEXGEN ERGONOMICS”) warrants solely to the

original purchaser (Customer) that (a) NEXGEN ERGONOMICS has good title to the Equipment and

that, upon Customer’s payment of the purchase price to NEXGEN ERGONOMICS, good title to the

Equipment will be transferred to Customer.

2. Limited Warranty of Condition and Operation. NEXGEN ERGONOMICS warrants solely to Cus-

tomer that when delivered to purchaser and for a period of one (1) year after the date of delivery to

Customer, the Equipment, will conform in all materials respects to NEXGEN ERGONOMICS’s pub-

lished specifications when used as described in NEXGEN ERGONOMICS’s written instructions, be

in good working order and free of defects in workmanship and materials. EXCEPT AS OTHERWISE

PROVIDED HEREIN, NEXGEN ERGONOMICS MAKES NO WARRANTY, EXPRESS OR IMPLIED, AS

TO ANY MATTER WHATSOEVER, INCLUDING WITHOUT LIMITATION ANY WARRANTY OF MER-

CHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE EXCEPT THOSE SET FORTH IN

THE DESCRIPTION AND DIRECTIONS ON THE LABELING OF THE EQUIPMENT. UNLESS THE

EQUIPMENT IS USED IN ACCORDANCE WITH THE DIRECTIONS ON THE LABELING AND THE

INSTRUCTIONS ACCOMPANYING THE EQUIPMENT, THIS LIMITED WARRANTY AND ANY WAR-

RANTIES IN SUCH DESCRIPTION SHALL BE VOID AND OF NO EFFECT.

3. Customer’s Exclusive Remedies. If within one (1) year from the date of delivery to Customer the

Equipment does not comply with the foregoing Limited Warranty of Condition and Operation, NEXGEN

ERGONOMICS will at NEXGEN ERGONOMICS’s option, repair, replace or refund the purchase price of

the defective Equipment free of charge to the Customer. Customers requesting repair, replacement or

refund are required to ship, the Equipment to NEXGEN ERGONOMICS at NEXGEN ERGONOMICS’s

facilities in Montreal, Canada, or at such other place as NEXGEN ERGONOMICS designates. As a

condition of this warranty, Customers must call NEXGEN ERGONOMICS’s Customer Service Line for

instructions on and prior approval of shipment prior to returning any defective Equipment.

4. Limitation of Liability. NEXGEN ERGONOMICS SHALL HAVE NO LIABILITY FOR ANY CON-

SEQUENTIAL, INCIDENTAL, OR SPECIAL DAMAGES BY REASON OF ANY ACT OR OMISSION

OR ARISING OUT OF OR IN CONNECTION WITH THE EQUIPMENT OR ITS RENTAL, DELIVERY,

INSTALLATION, MAINTENANCE, OPERATION, PERFORMANCE, OR USE, INCLUDING WITHOUT

LIMITATION ANY LOSS OF USE, LOST REVENUE, LOST PROFITS, OR COST ASSOCIATED WITH
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24 Limited Warranty

DOWNTIME. THE OBLIGATIONS CONTAINED IN THIS PARAGRAPH CONTINUE BEYOND THE

TERM OF THIS LIMITED WARRANTY.

5. Limitation of Liability. This Limited Warranty shall be governed by, and construed and interpreted in

accordance with, the local laws of the Province of Quebec (without application of its conflicts of laws

rules).
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25 Troubleshooting

25 Troubleshooting
NexGen is pleased to assist you with any questions you may have about our software or about the use of the

technology for your application.

Please contact us at:

email: techsupport@nexgenergo.com

telephone: 514-685-8593
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